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Welcome to some spreadsheet training. 

We’re using Excel 2007 in the prepared examples and notes but hopefully most will still apply and 

prove useful in almost any version of Excel and many for other software like OpenOffice Calc and 

Google Docs. 

The tasks range from pretty easy to pretty geeky and you can stop and start at any point. The scale 

ratings against the tasks indicate how they compare to Staff ICT Skills benchmark figures for 

teachers. 

The scenario 
You have a list of students and some marks in three subjects. You get increasingly demanding 

requests from your manager for information, sometimes to be presented in certain ways. You can, of 

course, ignore him or her and give up at any time! Should you wish to practice skills or techniques at 

a particular stage then there are notes available so that you can do tasks at your own pace too. 

Generally, though, the first tasks are ones that you will probably want to be able to do well and with 

confidence. The later ones will not be things that everyone will expect to do regularly, if at all, but 

you may find one or two of value in your particular role. 
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1 the data you need 
Instead of asking you to type in lots of data there’s a list of 50 or so students available for you to use. 

There is an Excel spreadsheet with just the data that you can download. 

the basic spreadsheet file studentdata2010.xls 

One of the nice things about spreadsheets, though, is that you can often copy data from tables on a 

web page and paste them into a spreadsheet to work with the data. If you would like to try that then 

is also available. 

the data in a table on the web 

https://spreadsheets.google.com/spreadsheet/pub?hl=en_GB&hl=en_GB&key=0AnA9aOhnBg9KdF

MzSTRXei1HMUZJUXNScUgzUm1SbXc&output=html 

Lastly, if you get completely stuck or would like to skip some of the early tasks which may well be far 

too easy for some people then I have also provided a complete workbook containing samples of all 

the tasks completed. This workbook does contain things called macros, though, which may be 

automatically disabled at your workplace. They are safe so, if you have the option, select the version 

that includes macros (the .xlsm file) when saving locally. If you can only access the .xlsx file then that 

will still be enough to show all but the last but one task. 

the whole workbook with samples students.xlsm 

Now you’re ready for the first task which is to keep the data safe before you start messing it up, er, I 

mean working with it! 

This is a really important thing to do. It’s called copying a sheet and, once you’ve got the hang of it 

you’ll be doing it a lot. 

There will be a sheet called original or something similar. Put the mouse on that sheet tab. Hold the 

Ctr key down and, keeping it down, drag the tab to the right with the mouse. You should see a little 

symbol like a sheet and a + sign. Let go of the mouse and then the Ctr key. You should now have a 

second sheet called something like original(1). That’s the one to use. Don’t touch the other one and 

then if you accidentally delete something of mess this sheet up you can still start afresh and save a 

lot of re-typing. 

There is also a way to do the same thing by right clicking on the tab and following the Copy 

instructions but the method outlined above is quicker. 

OK. Here come the manager’s requests... 

  

http://andrew-hill.net/ahi2000.com/studyzone/excel/studentdata2010.xls
https://spreadsheets.google.com/spreadsheet/pub?hl=en_GB&hl=en_GB&key=0AnA9aOhnBg9KdFMzSTRXei1HMUZJUXNScUgzUm1SbXc&output=html
https://spreadsheets.google.com/spreadsheet/pub?hl=en_GB&hl=en_GB&key=0AnA9aOhnBg9KdFMzSTRXei1HMUZJUXNScUgzUm1SbXc&output=html
http://andrew-hill.net/ahi2000.com/studyzone/excel/students.xlsm
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2. Delete some data 
There are three people that shouldn’t be on the lists now. 

Shaneem Asif 

Rabia Daniels 

James McCallef 

Delete them. 

Deleting data is best done by deleting the whole row. Just highlighting the cells and hitting the 

Delete key doesn’t really do what we want as it leaves a blank row. Blank rows may look like nothing 

but Excel reads them as zeros and that can cause trouble later. For example, you might get a blank 

row appearing at the top of a list of data sorted in low to high order. Or you may use a formula to 

count the number of people with, say, less than a score of 4. There shouldn’t be any but, again, Excel 

may read the zeros and give you a misleading answer. 

To delete a row click on its row number to highlight the whole row. Right click and select delete row 

from the menu. You can also press the Delete key if you’ve highlighted it that way. 

 

3. Add some data 
Just to show that you can enter data efficiently and accurately, enter yourself as a ‘student’ (you can 

invent a different date of birth!) with some marks for the three subjects. 

You’ll see that the existing data is in capitals and aligned in certain ways. Make sure yours matches it 

for consistency. 

One day you may well find that you have entered masses of data in capitals or lower case and 

actually need it in the other format. There is a quick way to fix that which will be included in the Tips 

section later. For just one entry, though, it’s simpler just to retype. To move from cell to cell use the 

Tab key. The cell you’re about to type in will have a box around it in normal sheets. 

If you do happen to put something where you shouldn’t and overwrite some existing data try 

pressing Ctr+Z which undoes your last action.  
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4. Tidy up the data 
Depending upon which version of the data you’re using the sheet may or may not look particularly 

attractive. The standard Excel2007 is a lot better than older versions but if you do have a sea of Arial 

then you definitely need to improve it for others to view. 

It’s also a good idea to add some colour and make headings more obvious. 

Now, there are ready-made pretty styles in Excel under the Format as table button. They look lovely 

and do have their uses but you’ll find many, if not all, of them a nuisance if you later change the 

order of data or add new rows etc. 

The problem is that they’re not that simple to remove. Basically, the technique to remove them is 

similar to how you might alternatively add your own shades or styles so you may as well do that in 

the first place and save yourself having to look up help files to remove Table Formats later. 

It’s your choice as to design but a suggested style would be to select the whole sheet – do that by 

pressing either Ctr+A or clicking on the very top left rectangle where the row numbers intersect with 

the column letters.. 

Change the font – Callibri, Century Gothic or Verdana are all better than Arial, for example, - a size 

between 10 and 12 is usually good for lots of data. Sometimes using a serif font like Times New 

Roman, Cambria or Georgia works well, especially with a lot of text content (the serifs make it easier 

to read). Please don’t use Comic Sans, though, or some script font unless you’re teaching under 5s or 

over 95s respectively! 

While it’s all selected, use the Fill and Text colour buttons on the Home menu to choose a suitable 

background and text colour. You need plenty of contrast. There’s nothing wrong with black on white, 

by the way, and that’s a lot cheaper to print too, but it’s worth trying an alternative out as you’ll be 

working with this data for a while and let’s say the manager wants something different. 

Deselect everything by clicking anywhere on the sheet. 

The headings can be changed in one go by selecting them all. You can select cells easily either with 

the mouse or clicking on the first in a group, holding the Shift key and then using the arrow keys to 

pick out the ones you want. This method is very useful, especially with laptops and awkward mouse 

panels. 

Check the alignment of data – sometimes numbers that are right aligned by default can bump up 

against text that is left aligned by default and look confusing. Make sure the heading alignment 

matches, or looks right, for the entries in each column too. Remember that some columns may 

expand and headings can appear detached from data later. 
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5. Sorting into A-Z and numeric order 
Before you do anything, copy the sheet. Sorting in earlier versions of Excel was a nightmare as 

sometimes only one or two columns would get changed and would not relate at all to the rest of the 

data! It was virtually impossible to get back to the original order unless it happened to already have 

been obvious. 

Later versions do try and warn you about potential disasters but making that extra copy is still a very 

good idea. Space is free, after all, and it only takes a second or two. 

Name the new sheet Sort by Group because that’s what’s wanted. 

A list of students with those in Group A at the top, then B and then C. 

Click in the Group column somewhere – but don’t highlight it. Then click on the Sort button on the 

Home toolbar. Excel recognises that it’s A-Z. There are only two choices – if you get it wrong first 

time and the Cs are at the top then try the other option. 

Check that all the data in the other columns has changed correctly too. 

 

6. More sorting needed 
Copy the sheet again. 

Now you need to keep the Group order but make the students appear in A-Z order within their 

groups. This needs a Custom Sort. 

 

In your example the first level would be the Group A-Z and then the next levels as above. 

The second one is needed because there are several Khans. 

Name this sheet suitably – eg Sort A-Z will do. 
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7. Finding just some data 
This is called filtering. You definitely need to copy the sheet before doing this because lots of the 

original data will seem to disappear and, whilst it’s easy enough to get it back, the reduced chunks of 

data are usually so reduced for a good reason and you’ll find yourself needing to refer to this again. 

So using a separate sheet can avoid you having to filter it next time. 

Use the Sort and Filter button on the Home menu and choose Filter 

 

The first request is for just those in Group A. You’ll se that little triangles appear in the heading row. 

Incidentally this is a great example for why your spreadsheets should have headings in a single row 

across the top. Try to avoid throwing in titles and headings or extraneous stuff that isn’t really data. 

There’s a place for that – the header (or footer). 
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In the panel that opens with the little arrow for Group clicked all the boxes will be ticked. That’s 

because, at the moment, all of these are being shown. You just need Group A showing so fiddle 

around with the boxes until just the A is ticked. For some reason best known to Microsoft the Select 

All square goes black which is confusing. 

Press OK and you’ll now have just the A group on screen. 

Often this simple procedure will be all that’s required for filters but the next step needs more work. 

Copy the sheet again and name the new one something like AMarks>14 as that’s what’s needed. 
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8. Find students that match several different criteria 

The task is to find just the Group A, B and C students who have achieved 14 or more in all 
three subjects. 

 
 
Clear the Group Filter to Select All. 

Click on the little arrow and choose Number Filters and then, in this case, Greater Than Or 
equal To... and enter the appropriate number in the next panel. Press OK and all the records 
related to people with less than 14 in each subject will go away, leaving what’s required. 
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9. Charts can make numeric data clearer 
Sometimes. But it is essential to choose the right type of chart and it will usually need some 

adjustment. Just highlighting the data and clicking on Insert Chart doesn’t often work and certainly 

doesn’t here. 

If you have a simple set of data where you can just select a bunch of cells then a chart of names and 

marks is easy. Unfortunately, here there is a load of unwanted stuff for the chart. You need the 

forename column and the three sets of marks only. 

To select just these bits you need to learn the Ctr and jump trick: select the forename column then, 

with Ctr key held down, select the three columns required in turn. 

 

Now you can do the Insert Chart bit, choose Column type and it will appear. 

There are buttons on the Chart Tools – Layout toolbar to add titles, labels etc. 

10 Change the colours 
The default set of colours may not suit your manager’s, or your, taste. It’s quite easy to change 

them, luckily. Click on one of the bars and you’ll see all those that colour get selected. In the Home 

menu, use the Fill colour button to choose another and it will be applied to all. 

Then pick another set and repeat. 

If you want to have different colours within a series then click on a bar in that series. Then click it 

again and it should become the only one selected. You can then change just that one. Repeat as 

necessary. 

11 Change the axis 
The chart still can look a bit odd, though, as Excel usually gets things wrong – in this case the scale 

for marks may go above 16 and have ½ points which aren’t appropriate. So some editing is required. 

To change the left axis, the y-axis, click on the scale somewhere to select it and right click. From the 

menu choose Format axis.  
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Here you can change things. In this case, the Maximum, Minimum and major units (the gaps) are 

what should be changed and you’ll find a minimum of 12 (not 0 as in the illustration here), maximum 

of 16 and major units of 1 work well. 
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12 Calculations 
These will have to apply to one of the sheets with all the current students listed so copy one of those 

– the last sorted one will be a good one. 

Now to add some formulae. The simplest ones are adding, subtracting, multiplying, dividing and 

totals. 

To add the contents of cell A1 and B1 the formula is =A1+B1. 

You would just type that in whatever cell you wanted the answer to appear. 

The others would be =A1-B1, =A1*B1 and =A1/B1. Note the * for times not x. 

To add everything between, say, A1 and Z1 the formula would be =sum(A1:Z1) or you can click on 

the Σ symbol on the home toolbar. 

None of these, though, are much use on this sheet. Below are some useful ones which are needed, 

starting with the easiest. 

Average 
An average mark in English can be put at the bottom of the English marks column. Select the cell 

where it’s to go. Enter a formula like this one (the actual references may be different on your sheet 

so be careful) 

=AVERAGE(F2:F57) 

Press enter and the answer will appear. Well, an answer will appear. It may have lots of decimals 

when it can only really be a whole number. Change that using the Decrease Decimal button on the 

Home toolbar. 

 

It isn’t obvious which of the two buttons does which so if you find it increasing then try the other 

one! 

Mode 
This is another type of ‘average’, displaying the mark that appears most frequently, for better or 

worse. To put this in for English, go to a cell a space or two below the Average one and enter this: 

=MODE(F2:F57) 

Press Enter and adjust the decimal display on this too. 
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Copying formulae 
You could type out similar formulae under the Maths and ICT columns but there’s an easier way. 

Select the one you just entered. You’ll see that the border now has a small black cross at the bottom 

right corner. Click on that and drag the mouse to the right. This will fill a similar formula across the 

next two rows. That technique can save so much time and works down as well. There is also a Fill 

button on the Home toolbar below the Σ symbol. 

Always check the results of this quick copying of formulae. There will be occasions when a formula 

may not be suitable for that procedure. It should be fine for the Averages and Modes though. More 

about that later. 

 

Ranges 
You’ll have seen that formulae such as these often use ranges – starting at one cell and running 

continuously to an end cell. If you think you may use a range a lot then you can give it a name 

instead of the awkward typing. 

At the top left of the sheet is a box that may have H60 in it, or something similar. This box always 

tells you which cell is selected and can also be useful to find one – you just type the cell reference 

and hit Enter and that cell will be selected – useful if you have a large sheet or can’t quickly find a 

cell by simply looking. 

You’ll be doing a few calculations on the numbers of students in Groups so to name the range might 

be useful instead of typing A2:A57 several times. To name a range, select it and then type the name 

you wish to use in that box at the top left in place of whatever’s in it. 

 

In this example I have named that range Group. 

Counting things 
Another really useful formula is one that counts how many cells in a range have something in them. 

=COUNTA does that. 

So you’ve been asked for a total number of students in the list to start with. At the foot of the Group 

column type 

=COUNTA(Group) 

and hit Enter. The answer is shown. 
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Now you have to find out how many are in each group. 

=COUNTIF does that. It needs two elements: the range to look at and what to look for. These are 

separated by a comma. So in a spare cell further down below the Group column type A. In the cell 

next to it type =COUNTIF(Group,A61) assuming that you put A in cell A61. (Change that cell 

reference if necessary). You should then see a number of the students in the Group column who 

have an A in that column. 

Now you can simply type B and C in the cells below A and copy the formula down into the next two 

cells. It will automatically adapt to refer to the cells with B or C in and so count the right numbers in 

those groups. 

You can also check the total of the three figures shown matches your earlier total. 

More counting formulae 
You also need to show how many students achieved more than 8 in each subject. Now you could do 

this by copying the sheet and using filters like an earlier task. But that would mean the answers 

being elsewhere. It’s not a silly idea but there is a better way this time. 

You want to look at a range and look for something. Just the same as looking for a group. So the 

COUNTIF formula should work. 

You haven’t named the subject marks so it’ll be something like (E2:E57) for English. What you’re 

looking for is anything greater than 8. The expression for that is “>8” (the inverted commas are a 

pain but necessary). So.. 

=COUNTIF(F2:F57,">8") 

should give the answer needed. It counts anything between F2 and F57 that is bigger than 8. This can 

be copied or ‘filled’ to the right for Maths and ICT with the formula adapting to the different ranges 

– one good reason for not naming them on this occasion. 

Formulae that automatically adapt when copied are great but there are times when you don’t want 

that to happen. 

Fixed cell references in formulae 
The last calculation required in this section needs you to divide the number of people getting more 

than 8 in subjects by the total number of students. Each formula will use the total you did earlier at 

the end of the Group column – and that cell needs to be shown the same each time. It can be ‘fixed’ 

so that it doesn’t change when a formula is copied. 

If the total was in A58 then the ‘fixed’ reference would be $A$58. 
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Percentage calculation 
To get the answer required, the calculation will be the number of students’ getting more than 8 in 

English divided by the total students and then that result shown as a percentage. 

=F62/$A$58 or similar will do that calculation for you and show a decimal like 0.68. To make this a 

more understandable figure click on the General button in the Number format section of the Home 

toolbar. 

 

Click on Percentage and it should then display as 68% or similar. 

That completes the fairly straightforward tasks. Things start getting a bit more complicated now so if 

you prefer to refresh your understanding of some of the procedures so far and maybe experiment 

with some other data or other exercises that’s fine. 

Needless to say, the manager is ever more demanding for those who feel able to continue! 
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13 Calculations with dates 
No, not the fruit or someone you’d like to go out with. Calendar dates. Like working out how old 

someone is on a particular day. 

This task requires you to show a student’s age on 1 September 2010. You have their date of birth so 

it ought to be easy but it isn’t. The problem is to do with how spreadsheets store dates and leap 

years as you’ll see. 

Excel 2007 stores dates as numbers. 1 January 1990 is 00001. 1 September 2010 is 40422. So taking 

one date away from another will give you a number – the number of days between the two dates. 

Then I use a bit of a cheat to turn days into years by dividing by 365.25 – the 0.25 allowing for the 

extra day we get every 4 years. This will work in most cases but not for the very young who may 

have not had a February 29th yet. 

The first step is to get Excel to turn the end date into a number. The formula for that is 

=DATE(year,month,day) so for 1 September 2010 that is =DATE(2010,9,1) 

Then take away the start date, here that’s a date of birth which will be in a cell, E2, say. 

=DATE(year,month,day)-E2 
 
By using a cell reference you may have guessed that this is a formula that could be copied down 
usefully to save time.  
 
That’ll give a huge number of days so divide by 365.25 to get years. 
 
=(DATE(year,month,day)-E2)/365.25 
 
There’s one more step. This number will inevitably have lots of decimals for the fraction of the year 
which you don’t need here. You can’t use the reduce decimals button this time because that will 
round the number to the nearest year when what you want is the lower number of complete years. 
The formula =INT(number) will strip off all the decimals or fractions and leave just the whole 
number, or integer, required. So, finally, this is the formula to take one date away from another and 
get years: 
 
=INT(DATE(2010,9,1)-E2)/365.25 
 
There are other methods that you may be able to think of and, if you really need an accurate 
formula there is one. Coming later. 
 
This would best go in a column next to the Date of birth. Highlight the Date of birth column and then 
use Insert Column to add one to the right. Put the formula in for the first student, check it gives a 
sensible result and then copy it all the way down. Double clicking on the little black cross bottom 
right of the selected cell with the formula should do this automatically. 
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14 Working across several sheets 
 
Sometimes sheets can get very cluttered or enormous with information that is difficult to find 
quickly. Or you may have some information on one sheet that you’d like to use on another. This 
section introduces how to move chunks of data to or access data on other sheets. 
 
For this particular task, you need to display just some of the data for the ICT subject and provide 
guides for new marks to be entered for a few students and entries in a comment box. 
 
This time, just open a new sheet – if there isn’t a spare one use Insert Sheet or click on the last tab. 
 
The information required is Forename, Surname, ICT mark and Comment as column headings. Type 
those in normally wherever you like. The first three are currently stored on several of your sheets. So 
for the first entry in the Forename column type = and then click on the sheet you wish to collect that 
data from. Click on the first entry on that sheet and press Enter. 
 
On your new sheet you should have the correct Forename in the cell and you may notice it has a 
weird-looking formula along the lines of ='sheetname’!C2 
 
That formula can now be copied down for all the other students. You may not know where to stop – 
just check as you go and either carry on or delete surplus entries. 
 
The next entries are for Surname and that may well be adjacent too in the source sheet. If so, then 
you can copy the first entry across to the right and then copy that down the whole column. 
 
Use a similar technique for the ICT marks. 
 
This linking to other sheets can save a lot of time. You can type the formula in too but it is usually 
simpler to get Excel to do it for you. 
 

15 Validation 
 
There’s also a need to have some control over what someone may enter in a cell. For example, an 
age that’s too young or old or a mark outside a set range. The technique is called validation and you 
can even set up a message that can range from a polite Are you sure? to a more brutal refusal to 
take their entry at all. 
 
If you look at the sample provided you’ll see on the valid sheet that a few students’ ICT marks have 
been left empty. Try entering some new marks and deliberately enter something wrong like 27 or 
something. In Lindsey’s box enter 16 as it seemed excellent. 
 
You’ll see how the validation I’ve set up works! Try entering some comments too for a slightly 
different type of feedback. 
 
Now to set up your own validation on your sheet. 
 
Select all the cells in column you’d like to apply a particular control to (or it may be just one, 
depending on what you’re working on). 
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The Data Validation panel can be opened from the Data menu. 
 

 
 

 
 
Use Settings to set the rule for a cell or the group of selected cells 
 
If you want to give someone warning of what to enter use the Input Message which will be displayed 
as soon as someone selects that cell. 
 
The important one, though, is the Error Alert where you can decide whether to advise them, provide 
information or prevent certain data being entered at all. 
 
No particular requirements have been specified in this task so invent something appropriate and test 
it. 
 
In the Comments column set up another type of validation – experiment with other settings and 
messages and don’t forget to check they function. 
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16 Using LookUp tables 
 

Often you will have a list of information and would like to get the spreadsheet to find 
something in that list and then use it elsewhere. For example you can display a cost of some 
shopping by getting the spreadsheet to look up items, read the prices and then work out the 
cost of what you’re actually buying from that list. 

There are huge advantages to this type of formula. For example you can maintain those lists 
on one information sheet but apply them in many places. And if the list information changes 
then your linked data will change automatically too. Lists stored somewhere else may also 
be safer, away from accidental change or deletion and not clutter up the other sheets. 

In this task you’re asked to make a simple table of how marks relate to a grading scale A+, A 
A- etc. The idea is that you’ll display all the students’ grade letters on a suitable sheet – 
probably one of the ones you’ve been working on. 

First, create a new sheet and give it a sensible name, like information perhaps. Copy or type 
the table in that sheet somewhere. Position isn’t important or what it looks like as long as 
there are no spaces between the rows and columns in the table and, something everyone 
forgets, sort the table into low to high order of the first column. 

Select the whole table and type a range name for it in the little rectangle above cell A1. This 
will avoid your having to type complicated cell references and is generally a lot simpler all 
round. 

In the sheet where you want to display the grades add column headings like English Grade, 
Maths Grade and ICT Grade. 

The formula you need is =VLOOKUP 

It has three components: what you want it to look up (eg a product price), where to find the 
table and which column of the table you want it to collect (eg the third column with price 
incl VAT). 

In your task the components will be the first cell with a students’ mark, say cell G2. The 
table location will be in the format filename!rangename. Note the exclamation mark after 
the file name and no spaces. The grade letters are in the second column. 

So a formula like this should work: 

=VLOOKUP(G2,students.xlsm!gradelist,2) 

You can also let the programme write the formula by typing =VLOOKUP( then clicking on the 
student mark cell, type a comma, then click on the sheet containing the table and selecting 
the whole table, typing another comma and finally typing 2 a closing bracket and hitting 
Enter. 
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Hopefully the correct first Grade letter will be displayed and you can safely copy the formula 
down the whole column. If your marks are in adjacent columns and the grade letters too 
then you can even copy the formula across to the Maths Grade and ICT Grade columns and 
the whole task is done with a single formula entry! 

You can have tables where you read across and then down where the information is in rows 
too. This uses the =HLOOKUP formula. 

  

17 IF statements 
 
You have already used =COUNTIF to count things in a range if they match something. The simpler-
looking =IF is also really useful but, because it can be very powerful, can be a little more 
complicated. 
 
Luckily the task you have isn’t too difficult, displaying a particular message relating to marks. 
 
The format of a simple IF statement has four components: the cell reference to be looked at, how it 
is compared, what to do if the match is good and what to do if it isn’t. For example, look at a price, is 
it less than £10?, if yes then display “I can buy this”, if no then display “Too much”. 
 
In this task it will be something like this: 
 
=IF(G2+H2+I2>40,"deserves a medal","") 
 
The first part adds up the marks and checks whether it is over 40. The second is the message if it is. 
The third, “”, means nothing will be displayed. You can put almost anything or nothing, between the 
“” marks. This is for text displays as a result. You can also use the formula to do another calculation 
in each instance which wouldn’t need the “” marks. 
 
You may have realised that you could have used an =IF formula to do the grade letters. For example, 
using the references in the previous section the formula below would put an A+ in the cell for a mark 
of 16. 
 
=IF(G2=16,”A+”,””) 
 
‘Now that looks a lot shorter’ I hear you say. The trouble is that if the mark wasn’t 16 nothing would 
go in the box. So the third component would have to be another IF formula: 
 
=IF(G2=16,”A+”,IF(G2=15,”A”,””)) 
 
And to deal with a mark of 14 requires yet another: 
 
=IF(G2=16,”A+”,IF(G2=15,”A”,IF(G2=14,”A-“,””))) 
 
and so on... 
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These are called nested IF statements. They look terrible and it’s difficult to remember where the 
brackets start and stop but where you haven’t got a table you can refer to or need to do different 
things with various results then you can see how useful they can be. 
 
  



Andrew Hill June 2013  page22 

 

18 Conditional formatting 
 
This is similar to IF but changes the colour of text or cell backgrounds depending on the settings you 
select. There are quite a few ready made for you. It’s probably simplest to try them out and see if 
they provide what you want. 
 
Here is an extract from the sample provided that highlights to top 10% marks in yellow and the 
bottom 10% in red. 
 

 
 
This would have been a tricky formula to do and it would have needed all kind of fancy stuff to make 
the colour changes which are beyond normal formulae. 
 
The Conditional Formatting panels are available on the Home menu. Select the area o the sheet that 
you’d like the display to apply to. You select the type you want and can then can edit the colours. 
 
It is also possible to write your own rules. For example you may want to have a complete row 
displayed in yellow for people with marks above 13 and in red for those below 8. That would be a 
fairly straightforward formula but, for some reason best known to Microsoft, there are confusing 
differences in how you type in some formulae compared to in a normal cell. It is not something 
easily covered in these notes or a short course!  
 
You should be able to meet this particular task requirements, though, without straying too far off 
the preset solutions. 
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19 What happens if? and other stories... 
 
There are many more tools in Excel, some being highly specialised and beyond the scope of this little 
course. However, the fact that it is so easy to link data from one place to another and join everything 
in one long string of calculations can make spreadsheets ideal for seeing what the effect would be of 
changing something on something else. 
 
This task requires that you create a device for testing how different fee income for the range of 
students listed would affect the total income if it were changed within certain limits. 
 
First you need to know about Subtotals. 
 
Where you have a lot of data it can useful to group it in various ways. In this task the numbers in 
each age group are required. Whilst this could be done with a formula the subtotal technique has its 
uses too and may be preferable to building awkward expressions. 
 
First the data needs to be sorted into Age order, either up or down. 
 
Then in the Data menu click on Subtotals to show the panel where you enter what you need to have 
displayed. In this case a total for each age group is to go under each group with a grand total at the 
bottom. 
 

 
 
Press OK and the sheet will change with the addition of some extra bits at the left as well as the 
entries required. By clicking the + or – signs on the left you can display more or less data or, as 
illustrated below, just the subtotals themselves. 
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There are tools called scenarios and what if and goal seek which do have their uses but can be quite 
awkward to use and understand. Often a simpler solution can be more useful and match your own 
requirements better. 
 
For that reason I propose to outline a non-standard solution to this task rather than attempt to 
explain how to use one of the ready-made tools. 
 
The end product will be a sheet which has some arrows you can click to make fees go up or down 
within set limits. The effect of the changes made will instantly be displayed in another cell so it is 
easy to see when the particular target income has been achieved. 
 
First, on a new sheet make a simple table with Age and Fee columns. 
 
Type in the current fees for each age which you’ll see on the Total income sheet or there is a sample 
below. 
 

Feelist 
 16 100 

17 200 

18 500 

19 600 

20 1800 

21 1200 
 
 
Below the fees a Total figure is needed. This will be, initially, 100*the number of 16s + 200*the 
number of 17s etc. You could use the Subtotals from the Total income sheet from the Subtotal task 
in your Total formula. 
 
Now a way to change the fee entries without having to type and delete. 
 
This uses the tools in the Developer menu. Click on Design mode. From the Insert tool panel select a 
spinner which looks like two small arrows. Drag the graphic to fill the cell next to the 16s fee. It will 
change to left-right arrows. 
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Right click on the graphic and select Properties. A complicated panel will open. Ignore most of that – 
look for the Cell reference that the spinner will control and enter the reference for the 16s fee cell. 
Then set a minimum and maximum value and change the steps by which it will change to 50. The 
default of 1 would take ages to change for what we’re doing here. 
 
Click OK to get out of that panel. Ignore any error message – it may think the existing value in the 
cell is outside the range set. 
 
Do the same for each of the 17s, 18s etc. 
 
Turn off Design mode and the arrows should now work instead of looking like a graphic. The entry in 
the Fee cell should change up or down by 50 each time it is pressed. The Total should also change if 
you have the formula right. 
 

 
 
By experimenting with different fees it should be possible to attain the figure required with a 
suitable combination of fee levels for this group of students. 
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20 Protect and survive! 
 
The final task is to try and stop users messing up your formulae or data by protecting parts of it. You 
can protect a whole workbook so that all anyone can do is look at it but the most likely thing you’ll 
want to do is protect a few cells with important entries you don’t fancy redoing. 
 
If you just Protect a sheet then the default setting is to lock all the cells so the first thing to do is 
decide which cells you’re happy to let people mess around with. 
 
This is fairly easy to do. Select a cell or a group of cells to ‘unlock’. You may think they’re already 
‘unlocked’ because you can just change them anyway at the moment which is a bit confusing. 
Basically ‘locked’ or ‘unlocked’ mean little until you ‘protect’. 
 
Then  right click and select Format Cells. 
 

 
 
Click to remove a tick from the Locked setting and press OK. 
 
Now for the fun part – finding where Excel have hidden the protection panel. It’s in the Review 
menu in 2007. In previous versions it was sensibly located in the Tools menu and I have no idea 
where it is in 2010, I’m afraid. 
 
Click on Protect Sheet. 
 
 



Andrew Hill June 2013  page27 

 

 
 
You can choose what users can do here so a tick means unprotected. You’ll usually want to let them 
access the cells you unlocked in the other menu. Press OK. 
 
Unless you are really really good at remembering passwords, the data is very sensitive or you have a 
jolly good reason for doing so, don’t set a password. It can be virtually impossible for normal people 
to find lost passwords and a lot of work can be wasted. You’ll need to download some software 
which will either cost money or be of uncertain origin if it’s free – a Google search revealed plenty of 
options but I’m not sure about any of them! 
 
In most cases, just protecting the sheet will be good enough to keep people from trespassing. 
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Analysis with a Pivot Table 

A Pivot Table is way to present information in a report format. The idea is that 
you can click drop down lists and change the data that is being displayed. For 
example, choose just one student from a drop down list and view only his or her 
scores. Pivot tables are a lot easier to grasp when you see them in action. 

The first thing you need for a Pivot Table is some data to go in it. Instead of typing 
all the data out, you can use this one: 

Download the Data for the Pivot Table 

The Pivot Table Data in an Excel Spreadsheet should look like this (only the first 
few rows shown here) 

 

Highlight the data that will be going in to your Pivot Table (cells A1 to D37).On the 
Excel Ribon, click the Insert tab. From the Insert tab, locate the Tables Panel. 

 

On the Tables panel click Pivot Tables. The Create Pivot Tables dialogue box 
appears: 

http://andrew-hill.net/ahi2000.com/studyzone/excel/PivotData.xlsx
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In the dialogue box above, the data that we highlighted is in 
the Table/Range textbox. You can select different cells by clicking the icon to the 
right of the Table/Range textbox. You can also specify an external data source, 
such as a text file, for the data in your Pivot Table. 

We've selected a New Worksheet as the place where the Pivot Table will be 
placed. Click OK. 

When you click OK, Excel presents you with a rather complex layout. The area on 
the right should look something like this one below: 
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It helps to have a look again at what we're trying to create. Here's a completed 
Pivot Table: 
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Now take a look at the Pivot Table Field List image again, the one above the 
completed pivot table. It has tick boxes for Month, Subject, Student, and Score. 
These are column headings from the original spreadsheet data. We've put 
the Month in cell A7 on our Pivot Table, Subjectis in cell B6, Student is in cell B4, 
and Score is the Average scores in cells C8 to G10. You'll see how it works, 
though. 

The idea is that you tick a box in the Pivot Table Field List, and then drag it to the 
four areas below. Excel will take care of the rest. 

 

So, tick all four boxes in the field list: 

Excel will create a basic (and messy) Pivot Table for you. But we're going to put 
our 4 fields into the 4 areas below. Here are the 4 areas we can drag to: 
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For the Report Filter, we want the name of a Student. For the Column Labels, we 
want theSubject, and for the Row Labels, we'll just have the Month. 
The Values will be the Averagescores. 

If you look at the Field areas after you have ticked all four boxes, however, you 
may see something like this: 

 
Month, Subject and Student have all been grouped under Row Labels. You can 
drag and drop these, though. 

So click on Student in the Row Labels box. Hold down your left mouse button, 
and then drag it in to the Report Filter box. If you don't fancy dragging and 
dropping, simply click the Student item with your left button. From the menu that 
appears, select Move to Report Filter: 
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Your Field areas will then look like this: 

 

Move Subject from Row Labels to the Column Labels area: 
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Your Field areas will then look like this: 

 

The Pivot Table on your spreadsheet will look a lot different, too. It should be 
looking like this: 
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Our Pivot Table is coming along, but the scores are all wrong, and it needs tidying 
up a bit. 

The reason why the scores from our Pivot Table are so strange is because Excel is 
using the wrong formula. It's using a Sum total when we want it to use 
an Average. 

The numbers have all been added up. But we want averages, instead. To change 
the formula, click on Sum of Score under the Values field area: 

 

You'll see the following menu: 

 
Select, Field Settings (or Value Field Settings in Excel 2010). You'll then see the 
following dialogue box: 
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Change the Formula from Sum to Average, and then click OK. 
Your Average formula won't be formatted to any decimal places. So highlight you 
data. On the Home tab in Excel, locate theNumber panel. Format your Averages 
so that it has no decimal places. Your Pivot Table will then look like this: 

 

Almost there! 

Look at cells A3, B3 and A4 above. These all have the not very descriptive names 
of Average of Score, Column Labels, and Row Labels. You can click inside of these 
cells and type your own headings, in exactly the same way as you would to enter 
text in a normal cell. 

In the new version of the Pivot Table below, we have renamed these cells. We've 
also centred the data. 
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Only one thing left to do - spruce up the table by adding a bit of colour. 

Click anywhere on your Pivot Table to highlight it. Now look at the Ribbon at the 
top of Excel . You'll notice a Design menu. Click on this to see the various design 
options. 

The Pivot Table Style Options panel is interesting. 

 

Select Banded Rows and see what happens. Now click Banded Columns. 

Next to this panel, there are lots of Pivot Table Styles to choose from. Select one 
that catches your eye. Here's our finished Pivot Table again, only with a different 
Style: 

 
And here's the original: 
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There's a lot more you can do with Pivot Tables, but we hope that this 
introduction has whetted your appetite! 

This guide and illustrations have been provided by HomeAndLearn who also have 
several other useful tutorials on their site. 

http://www.homeandlearn.co.uk/
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